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Introduction 
 

Welcome to the guide for the Adobe Photoshop CC plug-in “Astro Panel” version 4.0. 

This plug-in has advanced features to drastically reduce the workflow of the amateur 

photographer, the professional photographer an the videomaker in a matter of 

minutes. The workflow illustrated in this guide together with the description of the 

functions will help you to reach high quality digital processing. The functions integrated 

inside the panel will guide the user during the digital processing process because they 

are arranged in chronological order to instruct him in a correct digital post-production 

method. Astro Panel now integrates the advanced features of Fusion.  

"Astro Panel" is entirely in HTML5 and was created in collaboration with qualified 

expert personnel to maximize the experience of use and make the integrated functions 

fantastic. 

"Astro Panel" is not compatible with the versions of Photoshop CS, but only from the 

CC 2015 version up to the current CC 2020. The compatibility with the CC version of 

Photoshop is used to guarantee excellent performance and continuous updates. To 

take full advantage of the plug-in's features, I recommend you always update Adobe 

Photoshop CC to the latest version available. 

Let's move on to installing the plug-in in our PC / MAC. 

 

 
How to Install? 
 

https://astropanel.it/
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To install the Panel on your PC (Windows or MAC) we need to download the 

Anastasiy Extension Manager from the website https://install.anastasiy.com and 

perform these simple steps:  

- Select your operating system from the page;

 

- save the Zip ExtensionManager_win.zip in a folder;  

- Extract the files into a folder; 

- run the ExtensionManager file contained in the compressed package; 

- from the list of Adobe applications select Photoshop CC and then INSTALL; 

https://astropanel.it/
https://angeloperrone.it/
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- extract the panel files in a folder on your PC, select 

“it.angeloperrone.astropanel.zxp” 
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Once the package is installed on your PC, from Adobe Photoshop CC open the menu 

"Window" -> "Extensions" and click on "Astro Panel 4". 

If you are upgrading from version 3.2 to 4.0, you will have to uninstall the old version 

and install the new one again using the Anastasiy extension manager using the 

"Remove" command.  

 

Here is the video installation tutorial: 

https://www.youtube.com/watch?v=426V8ULLbPA&t=169s 

If you have problems installing Astro Panel try to perform a manual installation. 

https://astropanel.it/
https://angeloperrone.it/
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Open the file you downloaded from the Astro Panel website and copy only the folder 

named it.angeloperrone.astropanel contained in the "Manual Installation" folder in 

one of these folders, depending on the operating system: 

Win: C: Program Files (x86) Common Files CEP extensions 

Mac: / Library / Application Support / Adobe / CEP / extensions 

After this, open Adobe Photoshop CC and verify that the panel is present on the 

Window -> Extensions.  

https://astropanel.it/
https://angeloperrone.it/
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The Plug-in 
 

With the latest update, something new was introduced regarding the experience of 

using Astropanel. Once logged in we will find four main sections with the relative 

dedicated functions: 

- The "PRO" section dedicated to post-production of images has been completely 

renewed. Now the functions integrated in this section adapt to any type of 

photography. You'll be able to process white balance and color tone with a click, 

remove digital noise and annoying hot pixels, increase image sharpness, recover 

shadows and lights, and manage many effects like Orton and Glow; 

- The "ASTRO" section is dedicated to the post-production of astronomical images. The 

Astro section has been redesigned with the addition of new features and simplified to 

accelerate the workflow of astronomical images (milky way, startrail and deep sky); 

 - The "TOOLS-MASKS" section integrates advanced functions dedicated to the 

management of luminosity masks and color masks. Now it also integrates the advanced 

selection of masks in real time through the dropper positioned at the top right, the tab 

for resizing images for the web, for saving files and for printing; 

- The "FUSION" section is the biggest news of the version 4.0 update. Now Fusion is 

integrated into Astro Panel and you can add any image. 

 

 

 

 

https://astropanel.it/
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The image above shows all the sections of the update to version 4.0.

 

Let's illustrate the various functions of "Astro Panel" section by section. 

https://astropanel.it/
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The PRO Section 
 

The PRO section has been completely revised to contain all the new Astro Panel 

functions. From this section we can modify any type of photography, from 

astrophotography to the daytime landscape. 

We describe the commands of this 

section one by one. 

COLOR CORRECTION PRO, are controls 

for color correction, white balance and 

color saturation, precisely: 

- COLOR PRO, adjusts the automatic 

color corrections of the image; 

- TONE PRO, adjusts automatic 

corrections of image tones; 

- BALANCE PRO, find the average 

neutral color of an image and adjust 

the values of the range (half tones) 

according to this neutral color; 

- LAB PRO, increases the vividness of 

colors in Color Lab. 

The IMAGE CORRECTION PRO 

commands are for correcting artefacts 

and defects that affect all digital 

images: 

- REDUCE NOISE: helps the user to 

reduce the chromatic noise present in 

the photo without losing details and 

maintaining the nuclei of the nebulae 

and the brightness of the stars; 

https://astropanel.it/
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- REMOVE HAZE: removes the haze present in the photo and can be adjusted through 

the opacity of the layer; 

- ABERRATION: analyses chromatic aberrations and with the brush the user can remove 

the aberrations present in the image; 

- BANDING: banding or scaling is the phenomenon in which the shades of colours in an 

image are rendered as bands of colours. This function easily removes these defects. 

HOT PIXEL PRO is a set of functions to automatically remove "Hot Pixels": those 

annoying white or coloured pixels that typically appear when taking pictures in low 

light and with long exposure times. Click on one of the coloured buttons to increase 

the intensity of the function. 

SHARPNESS PRO is a group of semi-automatic functions that increase image sharpness. 

Let's analyze the commands: 

- BOOST: this very useful function in daytime images increases sharpness by using 

brightness masks (highlights and shadows); 

-  The HIGH PASS filter works on the contrast of the edges of the objects and you 

can adjust the ideal radius during post-production. I advise you to use it with 

caution in order not to exaggerate with the sharpness; 

- SUPER SHARP uses the "Advanced Sharpness" filter adjustable during post-

production and exercises greater control over the sharpness of the images; 

- LAB PRO increases the sharpness of the image on the "Luminosity" channel 

working in Color LAB. 

RECOVERY PRO is a set of automatic functions to recover lights and shadows in a single 

click. Click on 1 or 2 to choose the ideal intensity for your photo. 

EFFECTS PRO, as the word itself says, adds effects to our images to improve the final 

result or give that touch that is missing. We find: 

- CONTRAST PRO selectively increases micro-contrast in the photo; 

- VIGNETTE PRO adds vignetting and it is adjustable at will; 

- EXPOSURE PRO adjusts the final exposure of the photo and it is useful before 

publication on the Web or the printing phase. 

 

https://astropanel.it/
https://angeloperrone.it/
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GLOW EFFECTS, contains four adjustments to create the final Glow effect on your 

photo. You can choose between: 

- SOFT: to create a light Glow effect; 

- WARM: to create a Glow effect suitable for images with warm color temperature 

and preferably taken during the day; 

- COLD: to create a Glow effect suitable for images with cold color temperature 

and taken preferably after sunset or at night; 

- NIGHT: to create a Glow effect suitable for night images. 

ORTON EFFECTS contains four adjustments to create the final Orton effect on your 
photo. You can choose between: 

- BASIC: to create a light Orton effect; 
- PRO: creates a professional and adjustable Orton effect with curves; 
- WARM: to create an Orton effect suitable for images with warm color 

temperature and taken preferably during the day; 
- COLD: to create an Orton effect suitable for images with cold color temperature 

and taken preferably after sunset or at night; 

D&B EFFECTS, the Dodge and Burn, is a photographic technique entirely dedicated to 
light management. Through these functions you can "dodge and burn" your image. We 
have two different functions: 

- D&B - SIMPLE gives us the possibility to intervene on the dodge and burn using 
a black / white brush to obtain the desired effect; 

- D&B PRO automatically creates an aggressive dodge and burn working on the 
light masks and can be adjusted at the end. 
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The ASTRO Section 
The Astro section has been completely revised and now contains many more features 

than the previous version. 

We list all the functions in detail. 

AUTOMATIC PROCESS: this group contains two 
automatic functions that transform your 
astronomical photo in just one click. Two functions 
are available: 

- UNDEREXPOSURE - Automatic process Dark 
Images, (for underexposed or dark images); 

- OVEREXPOSURE - Automatic process Bright 
Images, (for images with correct exposure).

   
Automatic process example (Automatic process Dark Images). 

 

 

FIRST STEP: as its name suggests, this is the first group because it contains essential 

functions that the user should do when opening the image in Photoshop: 

- 32 - Convert from 32 to 16 bit image (DSS): sets the 32-bit 16-bit channel of the 

Autosave.tif file generated directly by the Deep Sky Stacker/Pixinsight software 

after the sum of the files tracked. Info in the graphic and video tutorial; 

https://astropanel.it/
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- RC - Reset colors Astrophotography: resets the tones and colors of the photo 

making them automated; 

- RG - Remove Green color Cast: removes the green cast contained in 

astronomical photos automatically and you can adjust the opacity to your liking.   

FALSE FLAT (REMOVE GRADIENT), the second group, automatically removes, in two 

steps, the "unpleasant" gradient that we find in our astronomical photos. There are 

3 commands that differ from each other based on the amount of gradient we want 

to remove. We don't need external software to do this because it's all integrated 

into "Astro Panel". 

   
Example of False Flat 50% (press "1" and then the 50% button). 

STRECHING IMAGE is a group composed of two commands that serves to extrapolate 

the hidden signal of the Milky Way / Deep Sky contained in the photo; there are two 

methods of extrapolation based on the exposure of the photo (bright or dark image) 

UNDER, fir underexposed images, and OVER, for overexposed images. Moreover, we 

have the DYNAMIC (Dynamic Strecth) mode, which amplifies the Milky Way signal or 

deep sky objects. 

https://astropanel.it/
https://angeloperrone.it/


15 

astropanel.it - angeloperrone.it 

 
Example of  Dynamic Strecth 

 

STAR TOOLS are five functions, each with its own task, and all work on the stars. They 

are mostly used in Deep Sky images to highlight objects in the deep sky and turn off 

the brightness of the stars. Let’s describe them: 

- SELECT - Star Mask selects all the stars contained in the image. We can make a 

quick selection with the command and perfect the color, intensity or brightness 

of the stars; 

- FILTER - Star Filter: with it, you can filter the stars contained in the image and in 

small percentage turn them off in order to emphasize the nebulae. You can use 

this function as many times as you need to filter as many stars as possible; 

- FADE - Feather Stars: blurs the sharpest images to bring out the colors of the 

stars; 

- VIVID - Saturate Color Stars: it increases the vividness and saturation of stars; 

- REDUCE - Reduce Stars Diameter: it reduces the diameter and makes the stars 

in the image point-like; 

- REMOVE - Remove all Stars eliminates all the stars from the image leaving all the 

nebulosity of the objects of the deep free sky. 

https://astropanel.it/
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Example of Remove Stars (Stars have been partially removed to emphasize nebulosity). 

 

ENHANCE-SHARPNESS is a set of commands used in astrophotography. Let's analyze: 

- NEBULA - Enhance NEBULOSITY amplifies the nebulosity of the Milky Way or 

deep sky objects, reducing the diameter of the stars; 

- BOOST - Precision Boost allows to increase the sharpness of the photo in a 

controlled way. It is advisable to use the white brush on the black level mask to 

increase the effect of the chosen command; 

- AUTOBOOST - Automatic Precision Boost increases the sharpness of the photo 

automatically; 

- EXTREME – Deconvulation: is a technique used in astrophotography that serves 

to give a hyper-sharpness to our photos. Adjust the opacity of the layer to your 

liking. 

https://astropanel.it/
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Example of combining "Nebula" and "Boost" 

COLOR BALANCE is a set of color management tools. We can adjust the color 
temperature on the fly and correct the chromatic aberrations around the stars: 

- MILKY - Selective Color Milky way: selective color correction for images with the 
Milky Way; 

- DEEP - Selective Color Deep Sky: selective color correction for Deep Sky images; 
- RED - Selective Color Red: extract, using a brush, the red color contained in the 

image; 
- BLUE - Selective Color Blue: extract, using a brush, the blue color contained in 

the image; 
- SATURATE - Saturate and Sharpen, accentuates the saturation and sharpness of 

the Milky Way or of deep sky objects; 

TOOLS is a set of quick access features: 

- SHA, MID, LIG generate a brightness mask for lights, for midtones and for 
shadows of level 1. If we want to access higher levels and generate more precise 
masks we have to move to the other tab; 

- R, Y, M, G, C, B, generate color masks useful for working selectively and precisely 
only on the selected colors. 

 

https://astropanel.it/
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Example of color and detail correction in lights and shadows 

 

  

https://astropanel.it/
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The TOOLS Section 
The Tools section has also been completely redesigned and now contains many more 
features than the previous version. 

We list all the functions in detail. At the top we have brightness masks and color masks 
divided into Lights, Midtones and 
Shadows. At the top right we have the 
eyedropper that allows us to query any 
area of the image and in real time 
understand which brightness mask to 
use. In fact, one of the masks will light 
up in a blue color. 

Below the masks, you will find some 
commands that will help you to easily 
identify where the selection works. We 
are talking about the group of 
functions "Fine Luminosity Masks" and 
"Fine Color Masks" which includes: 

- CREATE: to create brightness masks; 

- APPLY: to apply the changes to the 
image (single level); 

- DESELECT: to delete the selection 
(CTRL + D); 

- CANCEL: to eliminate the level; 

- DELETE: to delete brightness masks. 

While in the function group "Fine Color 
Masks" we find: 

- APPLY: to apply the changes to the 
image (single level); 

- SELECT: to select the screen mask; 

- DESELECT: to delete the selection 
(CTRL + D); 

- DELETE: to clear the level. 

https://astropanel.it/
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Another new feature of the new update is the ability to resize images as desired either 
for saving locally, for printing or for the web. In addition we also find a convenient 
function to add the watermark to our image before posting on social media.  

Other convenient features 

that immediately catch the 

eye are the quick 

adjustments. In fact we 

would no longer need to 

adjust the opacity of the 

layer, the nuance and 

density of the mask because 

we could do it directly from 

the panel below. Under 

these adjustments, the quick tools like Forward and Back, the Quick White Mask, Curve 

Level and Tonal Values, White Brush and Black Brush, Hue / Saturation and Color 

Balance have been optimized compared to the previous version. 

 

 

  

https://astropanel.it/
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Luminosity Masks:  
How to use? 
 

 In the "Tools" tab we find both brightness and color masks. Through the brightness 
masks we can overcome the 
limit of the sensor of our 
DSLR/mirrorless camera and 
modify specific tones of the 
image at will by giving our 
interpretation to the photo.  

Luminosity masks subdivide 
the image into Highlights, the 
lighter parts, Shadows, the 
dark parts, and Midtones, the 
intermediate tones. 

With the new update, you can 
select an area of the photo 
you are interested in using 
the eyedropper and 
automatically find the 
brightness mask we need to 
make the change. 

Through these, we can 
intervene with curves and 
brushes, saturate some areas 
of the image or desaturate 
them and lots of other 
functions. 

The tutorial below will give 
more information on how 
they work. 

https://astropanel.it/
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As we explained before, the dropper at the top right helps us to select in real time the 

area of the image we want to modify. Once the area to be modified has been selected, 

Astro Panel automatically identifies which brightness mask to use to proceed with the 

modification. 

 

Click on the highlighted light blue 

mask to create the brightness mask. 

Then if you want to manage the 
brightness/exposure of a mask, click 
directly on the curves adjustment 
and with the little hand you can 
adjust the display as desired. This is 
one of many examples to take 
advantage of brightness masks. If 
you use a black brush you can also 
cancel the effect of the selected 
mask so that it only coincides on the desired image area. 

https://astropanel.it/
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As you can see we have corrected the light contained inside the tent recovering only 

that area thanks to the Curve level lowering the high lights. You can use these 

operations on any brightness mask even using Tonal Values. For example, you can open 

shadows or correct haze in the image by adjusting the Tonal Values of the midtones. 

You just have to experiment. 

 

https://astropanel.it/
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Color Masks:  
How to use? 
 

Not only Luminosity masks, in Astro Panel there are also color masks. Introduced with 

version 2.0, it is an exclusive of this plug-in. Through the color masks you will be able 

to select a specific color in an area of the image using light masks (lights, shadows and 

halftones). 

Through the color masks you can not only make a very careful selection to manage the 

exposure, but you can saturate the colors, adjust the hue and the contrast. 

The operation is the same as for the brightness masks. In fact, using the dropper in the 

upper right corner we can identify the color and also the mask of correct brightness. 

In the photo you can see the selection of the mask in the brightness mask Light1 of the 

red color. 

 

In case you want to correct the lights of a certain color, as in this case of the red color, 

click on the R key in the Light Masks to create a new level and to apply any adjustment 

from the Image and Adjustments menu select the instrument that we need. This 

procedure applies to any image adjustment tool and any color mask. 

https://astropanel.it/
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In the figure above, the brightness of the red color was slighlty reduced and we also 

introduced some contrast in the image. As for the curves we can also selectively 

increase the saturation/luminosity of the chosen color. 
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https://angeloperrone.it/


26 

astropanel.it - angeloperrone.it 

The FUSION Section 
 

This tab is a concentrate of technology and a novelty for Astro Panel. Indeed, it 

integrates all the features of the Fusion plug-in reviewed and updated with new 

features. The Fusion tab is divided into four main sub-sections with the relative 

dedicated functions: 

- The "MERGE" section contains the most common types of image fusion developed 

from scratch and with proprietary code to speed up image summing operations; 

- The "STARTRAIL" section adds up to hundreds of images to obtain beautiful linear 

Startrails with particular effects on the stars; 

 - The "SKY STACK" section allows you to sum up images of the Milky Way and the deep 

sky very quickly. You can insert light frames, dark, bias and flat fields; 

- The "SKY HDR" section is one of the most advanced features of Fusion and blends up 

to 3 different exposures in one to achieve a dynamic range at night without equal; 

Let's illustrate the various functions of the "Fusion Section" section by section. 

 

 

 

https://astropanel.it/
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The MERGE Section 
 

The Merge section allows us to sum lots of images to create a beautiful "SILK" effect 

that can be obtained even without the use of ND filters. Not only that, you can blend 

images to achieve Focus Stacking, combine beautiful images in Classic HDR and NIGHT 

HDR (multi-exposure at night). 

Here is the list of the description of the commands: 

LOAD FILES: This button allows you to select the files to be merged to obtain the silk 

effect. 

 

GENERIC ALIGNMENT: This switch activates the automatic alignment of the levels, the 

one accessible to all in the section Edit> Automatic level alignment, and automatically 

finds the alignment method. [Tip: when using this alignment method, it is 

recommended to also activate the lens correction for a better result] 

 

TRIPOD ALIGNMENT: This switch does the exact same thing as the generic alignment 

switch, but as an alignment method it uses ''Reposition'' instead of ''Automatic''. 

 

LENS CORRECTION: This function allows you to open files by applying the distortion 

and vignetting correction available within the Camera Raw plug-in. 

 

CHROMATIC ABERRATION: With this function we can also activate the removal of 

chromatic aberrations, also available in the Camera Raw plug-in. 

 

SILK: Clicking this button starts the fusion to create the desired silk effect. 

 

FOCUS STACKING: Clicking this button starts the fusion to create the Focus Stacking. 

Focus Stacking is a digital photographic technique that involves performing a series of 

shots of the same frame, each on a different focusing plane in sequence, in order to 

obtain a final image with a depth of field greater than that obtainable with traditional 

techniques. 

 

HDR and NIGHT HDR: HDR photos are used to capture scenes with a wide dynamic 

range. Click on the HDR button to add day images or NIGHT HDR for night images. 

https://astropanel.it/
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The STARTRAIL Section 
 

Here is the description of the commands: 

 

LOAD FILES: This button allows you to select the files to be merged to get the startrail 

effect. 

 

TRIPOD ALIGNMENT: This switch activates the automatic alignment of the levels, the 

one accessible to all in the section Edit> Automatic level alignment, and automatically 

finds the alignment method. [Tip: when using this alignment method, possibly also 

activate the lens correction for a better result] 

 

COMET STAR EFFECT: This switch allows you to activate the fusion with the falling 

star effect. 

 

ROTATION DIRECTION: This switch allows you to activate the fusion with the falling 

star effect. 

 

LENS CORRECTION: This function allows you to open files by applying the distortion 

and vignetting correction available within the Camera Raw plugin. 

 

CHROMATIC ABERRATION: With this function we can also activate the removal of 

chromatic aberrations, also available in the Camera Raw plugin. 

 

BLEND: Clicking this button starts the merger, and at the end of it a message will 

appear that will show the time taken for the merging process of the shots. 

 

 

 

 

 

https://astropanel.it/
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The SKY STACK and SKY HDR Sections 
 

Here is a list of the description of the commands: 

LIGHT: This button allows you to select the light files to be merged. 

DARK: This button allows you to select the dark files to be merged. 

BIAS: This button allows you to select the bias files to be merged. 

FLAT: This button allows you to select the flat files to be merged. 

 

While the last three may or may not be selected, the light files must always be selected. 

 

ALIGNMENT: With this switch you can activate the alignment of the levels, and it's the 

one available on Photoshop in File> Automate> Photomerge. Its accuracy is good but 

approximate. If the photos are not aligned correctly, they are discarded. 

 

DUAL PASS ALIGNMENT: With this switch it is possible to activate the second alignment 

step. Activating this function, in fact, the photos will be aligned in an approximate way 

through the automatic alignment of Photoshop, to then be aligned to the maximum 

precision in a second step (with the maximum tolerance set in the slider "ALIGNMENT 

PRECISION"). This alignment algorithm is proprietary and is not present in any other 

Photoshop function. 

 

ALIGNMENT PRECISION: With this slider you can change the accuracy of the alignment. 

The recommended value is 3 pixels, as an ideal compromise between precision and 

alignment speed. The lower the pixel value, the greater the accuracy but also the time 

required for alignment. 

 

MAX ALIGN RADIUS: With this slider you can change the maximum radius in which you 

can align two images. If the set value is for example 15 pixels, the maximum possible 

alignment distance will be 15 pixels. 

If the photos are not aligned correctly, they are discarded. 
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AREA WIDTH: With this slider you can change the width of the selection area. This 

command must be used keeping in mind that the greater the size of the area, the 

greater the calculation time necessary for each iteration of the DUAL PASS ALIGNMENT, 

in favor of precision. 

For a normal 24MPX photo, the recommended approximate size is 150/250px, but if 

possible it is always better to prefer a larger area than necessary rather than too small. 

 

LENS CORRECTION: This function allows you to open files by applying the distortion and 

vignetting correction available within the Camera Raw plugin. 

 

CHROMATIC ABERRATION: With this function we can also activate the removal of 

chromatic aberrations, also available in the Camera Raw plugin. 

 

ALIGNMENT HELPER: In some cases, it may happen that the alignment of Photoshop 

fails to correctly process the alignment of the images due to particular lighting 

conditions. With this switch it is possible to favor alignment by performing 7 maximum 

attempts by varying some parameters. In this way, if without the help of the Alignment 

Helper a good part of the photos were discarded at the end of the elaboration, it is 

possible to repeat the fusion activating this function, allowing with good probability 

also to align the images that had otherwise been rejected. 

 

THRESHOLD: This slider allows to act on the threshold parameter of the DUAL PASS 

ALIGNMENT. If you don't know its impact in depth, it's always best to keep it at 128. 

It's an advanced command that allows the user to set the threshold to extract stars 

from the sky. For underexposed photos it may be necessary to bring this value to the 

left, while for overexposed photos to the right. 

It should be used sparingly, with the aim of making the alignment stars more evident. 

To set the optimal value, simply click the "PLACE" button under the "ALIGNMENT 

ZONE" item, click on the selection with the right mouse button and select "Deselect" 

(or for the more experienced click the CTRL + D keyboard shortcut for the Windows 

users or COMMAND + D for Mac users), then go to Image> Adjustments> Threshold, 

and move the slider so that you see the stars in a defined way, but avoiding artefacts 

such as stars that should be round that become deformed white spots etc. Perfection 

would be a big star that can be made as round as possible. Then, once you found find 
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the best value for you, keep it in mind, and after clicking Cancel (or possibly OK, it is not 

important), you can set that value correctly on the "THRESHOLD" slider. 

If you have not previously selected the alignment area you will have to click the "PLACE" 

button again and then when you have finished, click on "CONFIRM", or if you have 

previously selected the area, you can trivially close the document. 

 

PLACE: This button allows you to load the first photo selected in the Light item and then 

position the alignment area in the most appropriate way. 

The positioning of the alignment zone must be done with a very precise criterion, it 

must be centered on the largest possible star. In addition to selecting the Dual Pass 

alignment area, it can be used to immediately load one of our photos, so as to find the 

most appropriate threshold value based on specific needs. 

 

CONFIRM: At the end of the positioning, it will be enough to click this button so that 

the position of the area is recorded and applied during the processing. 

 

START: With this key it is possible to start the Stacking process. 

 

RESET: This button has the function of resetting the values of all the sliders to the 

default values. 
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Tutorial Merge (Silk, Focus Stacking, 
HDR e Night HDR) 
 

In this tutorial we will explain how to 

best use the MERGE section to 

achieve a beautiful Silk Effect, Focus 

Stacking, HDR or Night HDR. The 

operation is the same for all four 

casting methods. 

For this tutorial, we use a series of 

night files to upload as "NIGHT HDR". 

The first button to press is "LOAD 

FILES" to upload our photos. Once 

selected we must choose the type of 

alignment we want between 

"GENERIC" or "TRIPOD". We refer you 

to page 28 to discover the differences 

between the two commands. We 

choose "TRIPOD" (repositioning 

method) and active "LENS 

CORRECTION" to correct lens 

distortion and "CHROMATIC 

ABERRATION" to correct chromatic 

aberrations. 

Once all the parameters have been 

set, I press the "NIGHT HDR" key and 

wait for the final processing. 
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The RAW used for this test  were kindly sent by Andrea Consuele 

The end result is a layer as an advanced object so that you can modify the parameters 

again in Adobe Camera Raw (see the image above). 

This procedure is the same for the other types of fusion of the shots and the result 

obtained by the fusion can be enhanced and modified with the features present in the 

PRO section. 
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Tutorial for Startrail 
 

Now let's illustrate how to merge images to create a Startrail. The procedure is similar 

to that of the MERGE form. 

The first button to press is "LIGHT" to 

load the Startrail light frames. If 

available we can also load Dark, Bias 

and Flat frames. Once you have 

selected the photos to upload, we 

must activate the “TRIPOD 

ALIGNMENT” alignment. This switch 

activates the automatic alignment of 

the levels, the one accessible to all in 

the section Edit> Automatic level 

alignment, and automatically finds the 

alignment method. 

In the Stratrail tab we can also apply 

the "COMET STAR EFFECT" effect to 

give an effect to the stars streaked 

with shooting stars or to reverse the 

direction of the startrail using the 

"ROTATION DIRECTION" switch. 

We activate "LENS CORRECTION" to 

correct lens distortion and 

"CHROMATIC ABERRATION" to correct 

chromatic aberrations. 

Click on BLEND to start the image 

fusion and wait for our Startrail. 
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Tutorial Sky Stack – Sky Stack HDR 
 

In this tutorial we will explain how 

to stack images of the Milky Way 

or the deep sky using the Sky 

Stack and Sky Stack HDR section. 

 

The difference between the two 

types of merger is in the file 

upload. In the first type we will 

only add files that have a single 

exposure while in the second we 

can add more files with different 

exposures (different times or 

ISO). We can also load dark, bias 

and flat to increase the final 

quality of the file. 

 

Before starting the fusion of the 

images, we can edit all our files in 

Adobe Camera Raw without 

opening them in Photoshop CC 

(just click on the CLOSE button of 

Adobe Camera Raw) to generate 

the XMP files that will be read by 

Fusion. In this way we could for 

example correct the color or 

white balance of our images to 

have a correct final result. 

 

 

 

After this introduction and after 
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closing Adobe Camera Raw, the first button to press is "LIGHT" to load the light 

frames, then we move on to loading the dark, the bias and the flat field frames. 

If we don't have all the required file types it doesn't matter, Fusion will still 

process the merging of the images. 

In Fusion, we have 3 types of alignment available for summing images. We refer 

you to page 28 for technical details. 

In this tutorial, we chose 5 images of the Milky Way chased with star tracker 

Skywatcher Star Adventurer for a total of 120 seconds at ISO 1600. We can 

activate all 3 types of alignment or decide to activate only the first two. Next 

parameters to be set will be "ALIGNMENT PRECISION" and "MAX ALIGN RADIUS" 

which I set to 2 pixels to have a higher precision of alignment and 20 pixels the 

maximum radius in which it is possible to align two images and to avoid that 

some light frame. 

If you have also activated the "DUAL PASS ALIGNMENT" we have to make a small 

introduction. The "DUAL PASS ALIGNMENT" is a type of customized alignment 

with which we can decide the accuracy of the alignment. This type of alignment 

is activated by setting the maximum threshold of the stars to have a maximum 

alignment accuracy, that is by setting the slider "THRESHOLD".  

To set the threshold, proceed as follows: 

- Set the sample area of the image, without exaggerating, for "AREA WIDTH"; 

- I press the PLACE key and go to look for an area of the sample image. In my 

case I used the planet Jupiter as a sample star for alignment; 

- Go to Image> Adjustments> Threshold, and move the slider so that you see 

the stars in a defined way (see the following image); 
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- Once the best value is found, click on Cancel or OK (it is not influential), you 

can correctly set that value on the slider "THRESHOLD". 

- Press "CONFIRM" to confirm these parameters; 

- You can also correct lens distortion using the "LENS CORRECTION" switch and 

chromatic aberrations with the "CHROMATIC ABERRATION" switch. 

- To start image stacking press "START". 

If the images do not perfectly align, we click on the "RESET" button to reset all the 

original parameters and modify them so that the fusion is successful. 

Tip: If you are using light frames photographed with ultra-wide angle lenses and not 

starred, do not use the "LENS CORRECTION" function. 
 

 
 

Follow the graphic processing tutorial of the Milky Way on page 37. 
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Tutorial: how to edit Milky way? 
 

After stacking the Milky Way with the advanced features of Fusion we move on to the 
post production of our file. Post production is identical for a single Raw file. 
 

  
 

The first step is to reset the colors of the image and decrease the green cast that is 

present in the image. The commands to be used are "RC - RESET COLORS 

ASTROPHOTOGRAPHY" and "RG - REMOVE GREEN CAST". If you have already corrected 

the colors before stacking the images in Adobe Camera Raw, just try to remove (if 

present) the green cast. 

When we click on the "RG - REMOVE GREEN CAST" command, the background is 

duplicated and we can adjust the opacity to achieve the result we want. In this case I 

set an opacity of 30%. We combine the levels after arranging the tones and adjusting 

the green cast. 

https://astropanel.it/
https://angeloperrone.it/


39 

astropanel.it - angeloperrone.it 

 

Now we need to analyze our image by looking at the histogram at the top right. The 
analysis is necessary to switch to the other group of commands and understand which 
function to use. We are talking about the "STRECH IMAGE" group that serves to bring 
out the hidden signal that is in the Milky Way and to contrast the image, so we click on 
the "OVER" button which is used for overexposed images (as in this case). Use the 
"UNDER" button only if your image is underexposed. You realize it because the 
histogram pixels are turned to the left contrary to what happens in the image. 
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If the result is not satisfactory, we can always use the curves to darken the image if you 
use the "UNDER" command. With the new update we have a new "DYNAMIC" 
command available that amplifies the hidden signal of the Milky Way or deep sky 
objects even more. 
 

 
 

During the graphic 

elaboration it can happen 

that our image has very 

different shades from the 

reality that we have 

photographed. We will 

manage our image in Adobe 

Camera Raw with the use of 

the HSL panel. 

Try to move the various 

shades to get a sky as blue as 

possible and the shades of 

the milky way brown. The 

nucleus of the milky way 

must remain neutral and 
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tends to yellow. For the green airglow in the air above the horizon, eliminate it or 

reduce it as you like.  

The Airglow or nocturnal luminescence is a weak light emission of the earth's 

atmosphere and as a consequence, the night sky is never completely dark. 

 

Next step is the reduction of chromatic noise and digital noise present in our image. 

To do this we can use the dedicated group of functions "IMAGE CORRECTION PRO" in 

the PRO tab and click on the "REDUCE NOISE" function. We adjust the opacity of the 

duplicated layer to safeguard the detail. 

 

 

In just one click we have set the color noise and digital noise. We have other tools 

available but for now we will not use them. 

If you noticed, we skipped "FALSE FLAT". These functions are not indicated for the 

Milky Way, but essential for the post production of deep sky images. This command 

removes in two steps and automatically the "unpleasant" gradient that we find in our 

astronomical photos. 

We can give a softer look to our post production using the commands of the "STAR 

TOOLS" group. Try to select all the stars with the "SELECT" command and blend them 

with "FILTER". Other commands are available and use them according to your 

preferences. I refer you to page 14 to read the technical details. 
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The next step will allow us to extract even more signal from the Milky Way and increase 

the contrast of clouds and image. We are talking about the "ENHANCE - SHARPNESS" 

commands. 

The "NEBULA" command automatically performs its work by reducing the diameter of 

the stars and highlighting the nebulosity of the milky way or of deep-sky objects. This 

step can be skipped if you performed the "FILTER" on the stars. In addition, the 

"NEBULA" command takes a long time to complete and a fairly powerful PC / MAC. 

Now let's increase the details of our image. In our case we will use the "BOOST" 

command to highlight the milky way strands using a black or "AUTOBOOST" brush that 

will do it automatically for us. However, it is always recommended to work step by step 

to achieve a fine result without producing artifacts and destroying the image. 

With a black brush, we have hidden 

the areas of the image that we don't 

want to be affected by this 

sharpening method and left the 

protagonist of our image in white. 

See image on the following page.  
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At this point, we work on the color with the help of the "COLOR BALANCE" group. In 

our case, the command "MILKY - SELECTIVE COLOR MILKY WAY" helps us to adjust the 

colors of the Milky Way. If the result is not satisfactory or the colors are off, on the 

right we have the command "SATURATE" which enlivens the colors in a very 

accentuated way and increases the detail. 
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But what if the colors become very saturated or we want to correct a particular 

tonality? In this case we must reduce the saturation of the blue color and to do this we 

can use one of the colored buttons or open the "TOOLS" tab. Further information on 

page 23. 

We use the eyedropper to understand the blue color in which area of the image is 

found and we press the BLUE button of the brightness masks in the Shadows. 

 

 

Now let's proceed to reduce the saturation / vividness of the BLUE color by searching 

for the correct function from the Image menu -> Adjustments -> Hue / Saturation or 

Vibrance and press single level if the result satisfies us. We can increase the vividness 

or saturation of other main colors such as Red contained in the core of the image (for 

example). 

Now let's open Adobe Camera Raw and try to reduce the light pollution on the right of 

the image with just a few clicks. Through the graduated filter we can select the area 

where we will reduce light pollution and set these parameters. 
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Once the light pollution correction is finished, we suggest you manage and test the 

brightness masks in real time. In fact we can bring out other details from the image 

that are hidden in the nucleus of the Milky Way.  

Let us arm ourselves with 

the "TOOLS" dropper and 

try to find out which 

brightness mask to use. As 

you can see from the 

following photo we click 

on the "LIGHT3" mask and 

through a new level of 

curves adjustment we 

adjust the brightness of 

the core. 
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Click on "Single level" if the result satisfies us and move to the PRO tab to give a magic 

touch to our photo. Analyzing the image, we have available commands like "ORTON 

EFFECT", "GLOW EFFECT", "D&B EFFECT" to make the latest changes. Adjust the 

opacity of the effects to achieve the desired effect. 

We can conclude by saying that in just a few minutes and with the right commands we 

have arrived at a satisfactory result without creating artifacts, maintaining a 

remarkable detail and correct colors. 

On the following page you can view the before and after of the image just processed. 
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Tutorial: how to edit Deep 
Sky images? 
 
In the previous chapter we explained how to post produce the Milky Way with our 

panel "Astro Panel 4.0". The post production process is very similar and differs only in 

the use of some groups of commands such as "STAR TOOLS" and "FALSE FLAT". If we 

have stacked our images in Fusion and then reset the colors with the command "RC - 

RESET COLORS ASTROPHOTOGRAPHY". 
 

 
 

As in all the astrophotography images it can happen that there is a green cast.  

To decrease it the command to use is "RG - REMOVE GREEN CAST". 

When we click on the "RG - REMOVE GREEN CAST" command, the background is 

duplicated and we can adjust the opacity to achieve the result we want. We combine 

the levels after adjusting the green cast. 
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The next task to do is to analyze the histogram at the top right of our images. The 

analysis is necessary to switch to the other group of commands and understand which 

function to use. We are talking about the group "STRECH IMAGE" which serves to bring 

out the hidden signal from the image, so we click on the "UNDER" button that for the 

underexposed images. The "OVER" command for overexposed images. It is 

recommended to use the "UNDER" command several times only if your photo is still 

underexposed after the first click. 
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The image has now acquired a lot of brightness and we were able to bring out the 

signal of the nebula that was previously practically absent. Our task now will be to clean 

the image from this bright gradient with the "FALSE FLAT" commands. First command 

to use is "1" to generate the artificial flat that we then have to subtract from our 

starting image. Then we click on "25" or "50" or "75" based on the percentage of 

gradient we want to remove from the image. If the result does not satisfy us, we can 

go back with the dedicated key down and repeat the two operations.

 

Depending on the computing power of your computer, the command will take from 

30 seconds to a few minutes to process the artificial flat. To do a better job, we suggest 

using the tool "Clone Stamp" or "Patch" to hide the nebulae and other objects of the 

deep sky in order to obscure them from the subsequent processing. 
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Once you mask the areas of the image we want to protect, click on the desired 

percentage. In our case, we executed the "50" command and so subtracted 50% of the 

gradient that was present in the image. 

 

 
 

At this point we will try to extract even more signal and give depth to the nebula with 

the commands "ENHANCE - SHARPNESS". As explained in the previous chapter, with 

the command "NEBULA" we can reduce the diameter of the stars and the nebulosity 

of the image. This step can be skipped if you performed the "FILTER" on the stars. In 

addition, the "NEBULA" command takes a long time to complete and a fairly powerful 

PC / MAC. 
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From this point on, we will work on the Rosetta nebula to extract the detail and the 

dominant red color. We take out the fine detail with the command "BOOST" with the 

help of a white brush. With the command "EXTREME" (Deconvolution) we have the 

possibility to adjust the right compromise with the advanced sharpness. This technique 

is used a lot in astrophotography and is useful to reduce even the shake of 

astronomical images. See the image on the next page to see the effect of combining 

these commands. 
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We can reduce the brightness with the help of midtones in the brightness masks. 

Through the "Midtones2" luminosity mask and the tonal values we can reduce the 

"haze" in the photo. We can achieve the same result also with the "REMOVE HAZE" 

command on the PRO board and adjusting the opacity of the layer. 

The heavy postprocessing carried out so far can generate a percentage of digital noise. 

To correct this, we can use the "REDUCE NOISE" command on the PRO section. When 

we apply noise reduction the base level is duplicated and we can adjust the opacity of 

the effect. 
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Corrected the "defects" of the graphic elaboration we pass to correct the color. We 

have lots of color management features in Astro Panel, but color masks let us get the 

most out of our images.  

In our case, we can use the 

color mask "R - Red Mask 

Selection" of the "ASTRO" 

section that automatically 

selects the red color that is 

present in the nebula or 

use the dropper for 

brightness and color 

masks in real time from 

the "TOOLS" tab. After 

selecting the color mask, 

you can liven up the color 

using the "Hue / 

Saturation" or "Curve" 

adjustments. In the following image I worked with the saturation of the red color to 

make it more saturated and slightly bright. 
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Apply this workflow with any color or brightness mask. You can also mask the areas of 

the image that are not of interest for the current modification with a black brush on 

the mask next to the layer. 

 

If the result is not satisfactory, on the right we have the command "SATURATE" which 

enlivens the colors in a very accentuated way and increases the detail. 

As there is a bit of light pollution in our image, we open Adobe Camera Raw and try to 

reduce the light pollution in the lower right corner with just a few clicks. Through the 

graduated filter we can select the area where we want to reduce light pollution and 

set these parameters. 
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Once we are done with the processing let's move into the PRO tab to give a magic 

touch to our photo. Here we have commands like "ORTON EFFECT", "GLOW EFFECT", 

"D&B EFFECT" available to make the latest changes. Adjust the opacity of the effects 

to achieve the desired effect. The Orton effect is pleasant in deep sky images, so we 

will use one of the effects available to give the final touch to our elaboration. 

 

 
 

In just a few minutes and with the right controls we arrived at a satisfactory result 

without creating artifacts, maintaining a remarkable detail and correct colors. On the 

following page you can view the before and after of the image just processed. 

Then proceed to crop the photo to eliminate portions of the image that do not interest 

us and also to exclude areas affected by light pollution. The latter is only a suggestion. 

What we described in the tutorials is only a small part of the potential of Astro Panel. 

You can use the tutorials as a basis for your workflows to try to find the right 

combination of features and the right workflow. 
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All the material described in the guide is the property of Angelo Perrone Landscape 

Photographer. Reproduction, even partial, of images, texts or contents without 

authorization is prohibited. 

 

Thanks for reading. 
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